


 

Important Precautions and Safety Information

 

When using this product, these basic safety precautions should always be followed 
to reduce risk of fire, electric shock, and injury to persons:

 

1

 

Read and understand all instructions.

 

2

 

Use common sense whenever operating electrical appliances.

 

3

 

Follow all warnings and instructions marked on the product and in the literature 
accompanying the product.

 

4

 

If an operating instruction appears to conflict with safety information, heed the 
safety information. You may have misunderstood the operating instruction. If 
you cannot resolve the conflict, contact your sales or service representative for 
assistance.

 

5

 

Unplug the product from the AC wall socket before cleaning. Do not use liquid or 
aerosol cleaners. Use only a damp cloth for cleaning.

 

6

 

Do not place the product on an unstable cart, stand, or table. It may fall, 
causing serious damage.

 

7

 

Your product should never be placed on, near, or over a radiator, heater, air 
conditioner, or ventilation duct.

 

8

 

Do not allow anything to rest on the power. Do not locate your product where 
the cords will be abused by persons walking on them.

 

9

 

Do not overload wall outlets and extension cords. This can diminish 
performance, and may result in the risk of fire or electric shock.

 

10

 

Do not allow pets to chew on the AC power, or PC interface cords.

 

11

 

Never push objects of any kind into the product through case or cabinet 
openings. They may touch dangerous voltage points, creating a risk of fire or 
shock. Never spill liquid of any kind onto or into the product.



 

12

 

To reduce the risk of electric shock, do not disassemble the product. Take it to a 
qualified service technician when repair work is required. Opening or removing 
covers may expose you to dangerous voltages or other risks. Incorrect 
reassembly could cause electric shock when the unit is subsequently used. 

 

13

 

Unplug the product from the PC and AC wall outlet, and refer servicing to 
qualified service personnel under the following conditions:

• When any part of the power cord, plug, or connecting cable is damaged or 
frayed.

• If liquid has been spilled into the product. 

• If the product has been exposed to rain or water.

• If the product does not operate properly after instructions have been followed.

• If the product has been dropped, or the cabinet appears damaged.

• If the product exhibits a sudden and distinct change in performance.

 

14

 

Adjust only those controls covered by the operating instructions. Improper 
adjustment of  other controls may result in damage, and may require extensive 
work by a qualified service technician to restore the product to normal 
operation.

 

15

 

Avoid using this product during a lightning storm. There may be a remote risk of 
electric shock from lightning. If possible, unplug the AC power for the duration 
of the lightning storm.

 

16

 

SAVE THESE INSTRUCTIONS.
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Thank you for purchasing the Samsung SCX-1100 InkJet all 
in one. This multifunctional product provides printing, 
copying and scanning functions!

 

This chapter provides step-by-step instructions on 
setting up the product, and installing the software.
The chapter includes:

 

•Contents

•Control Locations and Functions

•Operation Panel Button Functions

•Choosing a Location

•Setting Up Your Product

•Loading Paper

•Installing Print Cartridges

•Changing the Display Language

•Turning Key Sound On or Off

•Setting Ink Save Modes

•Setting Power Save Mode
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Setting Up Your Product

 

Contents

 

Below is what is included with your product.

 

 *1. The shape of the power cord plug may differ depending on your country.
*2. CD-ROM of the MFP driver, SmarThru and OCR program.

SCX-1100 Colour and Black ink 
cartridges

Power cord*1
USB cable

CD*2 and 
SmarThru User’s Guide

Quick Install Guide, 
User’s Guide, Warranty Card
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Setting Up Your Product

 

Control Locations and Functions

 

Take a moment to familiarize yourself with the main components 
of your product.

 

Front View 

Output Tray 
Extension

Output Tray Top Cover 
To open, lift the cover.

Document glass

Operation Panel
(see page 1.5)

Cartridge Door
Grab the handle of the
door and open it wide.

Cartridge Holder
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Setting Up Your Product

 

Rear View

Top View

Parallel Connector

USB Connector

Connector Door
To access connectors, 
open it wide.

AC Power Socket

Paper Guide

Paper Support

Paper Bin
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Setting Up Your Product

 

Operation Panel Button Functions

 

1

 

Turns your machine on and off.

 

2

 

Launches Samsung Scan Wizard in the desktop 
window from which you can select the scan 
destination.

3

Adjusts the copy quality.

Adjusts the copy contrast to make copies 
lighter or darker than the original.

Selects the number of copies.

Makes a copy smaller or larger than the 
original.

Makes a black and white copy.

Makes a colour copy.

Allows you to set up special copy features 
including Fit to Page, Clone, Poster, and Mirror 
copy.
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Choosing a Location

To help guarantee trouble-free operation of your product, place it 
on a flat, stable surface near your workstation. Leave enough space 
to allow for easy paper loading, paper out and opening the top 
cover.

Do not place your product:

• In direct sunlight.

• Near heat sources or air conditioners.

• In dusty or dirty environments. 

4 Cancels a scan or copy job, or returns a menu 
item to its default setting.

5 Shows the current status and guides you 
through various menu setup.

6 Allows you to save ink.

7
Allows you to save paper by printing 2 pages 
on a single sheet of paper. (Only available in 
Black copy)

8 Enters menu mode.

9 Scrolls through menu items.

10 Confirms the selection on the display.
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Setting Up Your Product

1 Remove the shipping tapes from the front, back, and sides of 
the product.

2 Open the connector door.
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3 Connect the printer cable. Use only USB cable (shipped with 
your product) or  IEEE 1284 compliant parallel cable 
(purchase separately). 

NOTES: 
• If you are using a USB cable, you must be running Windows 98 or 

Me/2000/XP.
• When you connect to a USB port on a Windows computer, use the 

same USB port every time you connect your product.

4 Close the connector door.

USB 
connection

Parallel 
connection

OR
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5 Connect the power cord. 

Plug one end of the cord into the back of the product and the 
other end into a properly grounded AC outlet. 

As you plug it in, your product will turn on automatically.

Wait for “POWERING UP” to disappear from the display 
indicating the machine is on. To view your display text in 
another language, see page 1.17.

To turn off and back on, use the power button on the 
operation panel.
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Loading Paper

The display shows “ADD PAPER” and “PRESS ENTER” alternatively 
if no paper is loaded when printing is required. The paper bin will 
hold approximately 100 sheets of plain paper. 

In a stand-alone copy mode, you can use A4-, letter-, or legal-size 
paper. Your product is preset to A4. If you want to use other sized 
paper, use Setup button to set the paper size. For details, see page 
3.2. 

For PC printing, you can use smaller sizes of paper. For details, see 
page 4.10.

1 Pull the paper support on the paper bin all the way up.

2 Fan the paper and insert it with the print side facing you. 
Ensure that the right edge of  the paper is in contact with the 
right side of the paper bin. Do not exceed the specified 
capacity. 

NOTES: 
• Do not force the paper down into the machine.
• It is recommended to load a stack of paper (more than 20 sheets) 

to ensure proper paper feeding.

Paper support
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3 Squeeze the left paper guide and move it to the right to 
match the width of the paper.

4 Pull the output tray and output tray extender on the front of 
the product, all the way out.

NOTE: If you are using legal-
size paper, do not pull the 
output tray out. Push it in, or 
it may cause paper jam when 
the paper prints out.

Paper guide
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Installing Print Cartridges

Your product comes with a black and a colour cartridge. You can 
purchase an optional photo cartridge and install it instead of the 
black cartridge. See page 1.16 for the options you can purchase.

Use this procedure when installing print cartridges for the first time. 
To install replacement print cartridges, refer to “Replacing Print 
Cartridges” on page 6.9.

NOTE: There are two types in the black and the colour cartridge by 
the yield: Standard and High yield. Before proceeding to install, you 
need to check which cartridge type you have. When you install the 
cartridges, you will be asked if it is Standard or High Yield. To find out 
the type, please refer to the table on the page 6.9.

1 Unwrap and remove the colour print cartridge from its plastic 
bag. Hold the print cartridge at the top only. Do not touch the 
electrical contacts.

Carefully remove the sealing tape covering the print head. 

2 Grab the handle on the cartridge door and open the door. 

Grab the handle.



1.13Setting Up Your Product

3 The cartridge holder moves to the install position. 

The colour cartridge will be inserted into the left side of the 
cartridge holder and can be identified by a yellow tab on the 
top of the holder. 

The black (or photo) cartridge will be inserted into the right 
side of the cartridge holder and can be identified by a green 
tab on the top of the holder.

4 Place the colour print cartridge into the left side of the holder.

5 Push the colour cartridge back until it clicks into place.

Yellow tab indicates colour
cartridge position.

Green tab indicates black or
photo cartridge position.

colour ink cartridge



1.14 Setting Up Your Product

6 Unwrap and remove the black print cartridge from its plastic 
bag. Holding the cartridge at the top, carefully remove the 
sealing tape covering the print head. 

Place the black print cartridge into the right side of the holder. 

7 Push the black print cartridge back until it clicks into place.

8 After installing the print cartridges, close the cartridge door.

9 When you close the door, the display shows “COVER CLOSED” 
and then “NONE CHANGED?”.
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10 Press the Scroll button  or  until you see “BOTH 
CHANGED?” in the display and then press Enter.

11 The display shows “NEW COLOR”. Press Enter.

12 The display shows “STANDARD COLOR”. If you have installed 
a standard capacity colour cartridge, press Enter. If not, 
press the Scroll buttons (  or ) to display “HIGH YIELD 
COLOR” and then press Enter.

13 The display shows “NEW BLACK”. Press Enter.

14 The display shows “STANDARD BLACK”. If you have installed a 
standard capacity black cartridge, press Enter. If not, press 
the Scroll buttons (  or  ) to display “HIGH YIELD BLACK” 
and then press Enter.

15 Cartridge Alignment begins automatically by printing the 
Cartridge Alignment form. Use this form to identify the 
straightest line in each of six alignment areas. 

By selecting the straightest line for each pattern, you will 
optimise the print head alignment.
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16 Looking at the Cartridge Alignment form, identify the 
straightest line in Alignment A.

Using the Scroll buttons (  or ) to select the number of 
the straightest line. Press Enter when the number displays.

17 The display accepts the number and moves to Alignment B. 
Repeat steps 16 and 17 for Alignment B-F.

18 When you finish entering the number for Alignment F, the 
display returns to Standby mode.

NOTES:
• When either print cartridge starts to run out of ink, replace the 

empty print cartridge. If you do not have a new replacement for the 
empty print cartridge, leave the empty print cartridge in the 
product. The product will not print with only one print 
cartridge installed.

• Keep a spare print cartridge on hand. When buying print cartridges, 
check the part numbers referenced below to ensure buying the 
correct print cartridge. These print cartridges have been specifically 
designed to work with your product to produce results that are 
always clear and sharp.

• If you want to purchase a new print cartridge, either contact your 
point of purchase or any Lexmark authorized supplies dealer.

Cartridge type Part number

Black cartridge

High yield Lexmark 12A1975

Standard Samsung INK-M50 
Lexmark 12A1970

Colour cartridge

High yield Lexmark 15M0125

Standard Samsung INK-C60 
Lexmark 15M0120

Photo cartridge Lexmark 12A1990

Last Alignment
Entry

Number Range Alignments 
(A, B, C, D, E, F)
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Changing the Display Language

To change the language that is displayed on the LCD display, take 
the following steps:

1 Press Setup on the operation panel. The display shows the 
first menu; LANGUAGE. Press Enter. 

2 Press the Scroll buttons (  or ) until you see the language 
you want in the display and then press Enter to save the 
selection.

Turning Key Sound On or Off

You can turn the key sound on or off. If you turn the key sound on, 
key tone sounds each time you press a button on the machine’s 
operation panel.

1 Press Setup on the operation panel.

2 Press the Scroll buttons (  or ) until you see “KEY 
SOUND” on the display and then press Enter.

3 Press the Scroll buttons (  or ) to select “ON” or “OFF” 
and then press Enter.
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Setting Ink Save Modes

You can enable or disable Ink Save features with the touch of a 
button. 

The Ink Save feature allows the printer to use less ink on each 
page. Activating this mode changes print quality to draft mode so 
that the life of the ink cartridge extends, but may lower the print 
quality. 

NOTES: 
• If you need better quality, disable the Ink Save and set the print 

quality as you want.
• You cannot use Ink Save either when Paper Save is on, or with 

Photo Cartridge installed.

Press SAVE Ink on the operation panel. If the button backlight is 
on, Ink Save mode is active and the machine uses less ink to print 
a document. 

If the button backlight is off, Ink Save mode is disabled and you will 
print with normal quality.

Setting Paper Save Modes

You can enable or disable Paper Save featur with the touch of a 
button.The Paper Save feature print 2 pages on a single sheet of 
paper to save paper. 

1 Press SAVE Paper on the operation panel. The display shows 
“ON” or “OFF”.

2 Press the Scroll button (  or ) to change the setting. To 
enable the Paper Save mode, select “ON”. Or select “OFF” to 
disable the mode. Then press Enter.

NOTE: The Paper Save feature is applied only in Black copy mode. 
While the paper save mode in enabled any changes you made through 
the special copy does not apply even though it is accessible, and the 
print Quality sets to “NORMAL”.
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Setting Power Save Mode

Your product reduces power consumption when it is not in actual 
use. The Power Save mode setting determines the length of time 
the machine waits after a job is printed before it switches to a 
reduced power state.

1 Press Setup on the operation panel. The display shows the 
first menu; LANGUAGE.

2 Press the Scroll buttons (  or ) until you see “POWER 
SAVE MODE” in the display and then press Enter.

3 The display shows the time available. Press the Scroll buttons 

(  or ) until you see the desired time in the display. The 
current setting is tagged with a  at the end of the display.

4 Press Enter to save the selection.
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MEMO



2 INSTALLING SOFTWARE

This chapter provides information on installing the supplied 
Samsung software. You must install the Samsung software 
to use your product as a printer and scanner.

The topics included in this chapter are:

•About Samsung Software

•System Requirements

•Installing Samsung Software

•Configuring Fax Gate and Internet Gate

•Uninstalling Samsung Software



2.2 Installing Software

About Samsung Software

You must install the SmarThru CD-ROM after you have setup your 
product and connected it to your computer. The SmarThru CD-ROM 
includes the following:

• MFP Driver

• SmarThru Software

• OCR Software (AnyPage Lite)

MFP Driver 

To use your SCX-1100 as a printer and scanner, you must install the 
MFP driver.

SmarThru Software

SmarThru is the accompanying software for your SCX-1100 
multifunctional product. SmarThru contains a powerful image 
editor that allows you to edit images in many ways and also 
includes powerful Internet mail client software. With SmarThru, 
you can save the scanned images in a dedicated storage area for 
subsequent editing, sending via e-mail or fax, printing, and 
processing by other programs of your choice. 

OCR Software (AnyPage Lite)

OCR (Optical Character Recognition) is software that has the ability 
to recognize most character formats, so that a scanned document 
can be read and edited with word processing software.



2.3Installing Software

System Requirements

Before you begin, ensure your system meets the minimum 
requirements.

Supported Operating System

Windows 95 OSR2/Windows 98/Windows 98 SE/Windows NT 4.0 
Workstation or Server with Service Pack 3/Windows 2000 
Professional or Advanced Server/Windows XP Home edition or 
Professional.

Minimal Requirements

• Disk space: 130 MB for installation 

• Memory: 64 MB 

• CPU: Pentium II 233 or higher

• Required software: Internet Explorer 4.01 or above

Recommended

• Disk space: 250 MB for installation

• Memory: 128 MB

• CPU: Pentium II 400 or higher

• Required software: Internet Explorer 5.5 or above

NOTES: 
• Administrative rights should be set for installation on Windows NT 

4.0/2000/XP.
• Windows 95 versions prior to OSR2 are not recommended due to 

compatibility with OLE/COM libraries.
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Installing Samsung Software

NOTES: 
• For Windows 95/98/Me/2000/XP users, cancel the “New Hardware 

Found” screen when the computer boots up.
• Make sure that your product SCX-1100 is plugged in and connected 

to your computer’s parallel port or USB port before installing 
software from the CD. Windows 95 and Windows NT 4.0 do not 
support USB connection.

1 Insert the supplied SmarThru CD-ROM into your CD-ROM 
drive.

The SmarThru CD-ROM should automatically run and opening 
window appears.

If the opening window does not appear, click Start, and then 
Run. Type X:Autorun.exe, replacing “X” with the letter of 
your drive, and click OK.

If you are asked to select the language, choose your desired 
language.

2 Click Install the Samsung Software on your PC. 

3 Follow the on-screen instructions and click Next. 

Installs the 
Samsung 
Software on 
your PC

Uninstall the 
Samsung 
Software. See 
page 2.12.
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4 The SmarThru installation supports three types of setup:

• Typical: Program will be installed with the most common 
options and is recommended for most users.

• Compact: Only the MFP driver will be installed.

• Custom: You may choose the options you want to install. 
Recommended for advanced users.

5 Click Next. 

If you select the Custom installation, you may choose the 
options you want to install.

• SmarThru Software: to scan and edit images and 
   work with electronic documents.
• OCR Software: AnyPage Lite software to enable OCR. 
• MFP Driver: to print and scan.
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6 You can choose SmarThru networking option. This feature 
allows you to share the modems on your computer and the 
scan device SCX-1100 via a network or to access these shared 
devices located on other computers. 

Stand-alone configuration does not allow you to use any 
networking features such as Remote Fax or Remote Scan 
service.

If you selected SmarThru networking, you can select to 
install server, client, or both. 

Server allows you to share local fax modem and/or scanner 
over a LAN. You can control sharing by managing remote 
service user. Client allows you to use Remote Fax or Remote 
Scan services provided by SmarThru Remote Services Server 
over a LAN. You need to have a client account. These accounts 
are provided by the server. For details on Remote Fax/Scan 
Services, please refer to the SmarThru User’s Guide.
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7 Click Next.

8 When the installation is completed, shut down and restart 
your computer. 

If your computer does not shut down and restart 
automatically, you must shut it down manually and restart it 
before the changes will be saved.

NOTE: When you install the software, the Digital Signature Not 
Found window appears in Windows 2000 and Windows XP. Click OK in 
Windows 2000 and click Continue Anyway in Windows XP.
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Configuring Fax Gate and Internet Gate 

If you select SmarThru networking Server option (see page 
2.6), when your computer restarts after the Samsung software has 
installed, you will be prompted to configure the fax and Internet 
gates allowing you to send and receive faxes and e-mails on the 
SmarThru system. 

If you select the Stand-alone or SmarThru networking Client 
option (see page 2.6), the following wizards appear only the first 
time you try to launch Mailbox in the SmarThru program. For 
information on SmarThru, please refer to the SmarThru User’s 
Guide.)

NOTE: To configure the Internet gate, you must enter your e-mail 
address, incoming (POP3 or IMAP4) and outgoing (SMTP) mail server 
address, and account name. Ask your Internet service provider or on-
line service provider for the information on your Internet gate 
configuration.

1 When the New Modem Wizard appears, choose the system 
modem installed in your system and then click Next. This fax 
modem will be used by SmarThru Fax Gate for sending and/or 
receiving faxes.

2 Click Finish to save the modem setting.
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3 Enter your name and e-mail address, then click Next. The 
e-mail address has been assigned to you by your Internet 
service provider.

4 Enter the addresses of your incoming and outgoing mail 
servers. Choose the incoming mail server type, then click 
Next. Your Internet service provider will be able to provide 
you with this information.
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5 Enter your account name and password to access your 
Internet mail server, then click Next. Your Internet service 
provider will be able to provide you with this information.

6 Enter the account record name, then click Next. 
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7 Click Finish to quit the wizard and enable Internet e-mail 
service.

NOTE: If you wish, you can reconfigure the Internet gate later by 
using SmarThru Configuration. For details, refer to the SmarThru 
User’s Guide.
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Uninstalling Samsung Software

Uninstall is required if you are upgrading the software or if your 
installation fails. You can uninstall all software including SmarThru 
and MFP drivers using the SmarThru CD or selectively uninstall the 
desired item using the Window unInstallShield.

NOTE: Before beginning un-installation, ensure all applications are 
closed on your PC. A system reboot is required after the software is 
un-installed.

Uninstalling the MFP Driver

1 Start Windows if not already started.

2 From the Start menu, select Programs, then select 
Samsung SCX-1100 Series.

3 You can select the component in the MFP driver to uninstall 
individually.

If you want to uninstall the scan driver, select TWAIN Driver 
Uninstaller.

If you want to uninstall the printer driver, select SCX-1100 
Series Uninstall. Restating your computer will be required. 

in case of Windows 98
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4 When your computer confirms your selection, click Yes. The 
selected printer driver and all its components are removed 
from your computer.

5 When un-installation is done, click OK. 

6 The message box recommends you restart your computer. 
Click OK, then restart Windows.

NOTE: If you want to install the printer driver or the scan driver 
using the SmarThru CD-ROM, make sure that you select the Setup 
Type to Compact. Or select Custom then select MFP Driver. For 
details, see page 2.5.

Uninstalling Samsung SmarThru

1 Start Windows if not already started.

2 From the Start menu, select Programs.

3 Select Samsung SmarThru, then select SmarThru 3 
Uninstall.
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4 When your computer asks you to confirm your selection, click 
Yes. The Uninstall Options dialog box appears.

Uninstall options are:
• Backup and delete: Backs up all your data and options to a 

safe place. Then removes SmarThru system including the 
data.

• Delete: Deletes all the SmarThru data and options. No 
backup or copying takes place. Be careful while using this 
option as you can easily lose your data.

• Leave intact: Uninstalls SmarThru software leaving data 
and option intact. This can be useful, if, for example, you 
decide to install Stand Alone configuration over SmarThru 
Networking. In this case, uninstall Samsung SmarThru 
having Leave intact option set and install SmarThru Stand 
Alone configuration.

5 After selecting the uninstall option, click Next.



2.15Installing Software

6 Follow the on-screen instructions to complete the un-
installation. The SmarThru software and all components will 
be removed. 

7 When un-installing is done, click OK. The message box 
recommends restarting your computer.

8 Click OK.

Shut down and restart your computer to complete the un-
installation process and save your changes. 
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Using the SmarThru CD-ROM

You can un-install both the MFP driver and the SmarThru software 
with the CD-ROM you have used to install the software. 

1 Insert the SmarThru CD-ROM into your CD-ROM drive. 

The SmarThru CD-ROM should automatically run and the 
opening window appears. (If the opening window does not 
appear, select Run from the Start menu, then type 
X:Autorun.exe, replacing “X” with the letter of your drive 
and click OK.

If you are asked to select the language, choose your desired 
language.

2 Click Uninstall the Samsung software on your PC. 

3 Follow the on-screen instructions to complete un-installation.

You must shut down and restart your computer before any 
changes you have made will take affect.
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You can use your SCX-1100 like a standard copier. You don’t 
even have to turn your computer on. The buttons on the 
operation panel let you make all the basic settings: paper 
type and size, copy size, copy contrast and quality, number 
of copies, and colour or black and white. 

This chapter includes:

•Setting Paper Size and Type

•Loading the Original Documents

•Copying a Document

•Setting Copy Options

•Using Special Copy

•Changing Default Settings
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Setting Paper Size and Type

First make sure you have paper loaded, following the instructions 
in “Loading Paper” on page 1.10. Then you have to set the paper 
size and type using the operation panel buttons.

NOTE: These settings are applied to the stand-alone copy mode only. 
In PC printing mode, you have to select the paper type and size in the 
application program you use.

Paper Size

After loading paper, take the following steps to set the paper size 
from the operation panel:

1 Press Setup on the operation panel. The display shows the 
first menu: “LANGUAGE”.

2 Press the Scroll buttons (  or ) until you see “PAPER 
SIZE” in the display.

3 Press Enter. The current setting is tagged with a  at the end 
of the display. 

4 Press the Scroll buttons (  or ) until you see the paper 
size you are using in the display.

5 Press Enter to save the selection.

NOTE: When you use legal-size paper, do not pull out the paper 
output tray. If you do, a paper jam may occur.
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Paper Type

You can use special media such as inkjet, transparency, and photo 
paper as well as plain paper. After loading any special type of 
media, set the paper type using this menu:

1 Press Setup on the operation panel. The display shows the 
first menu: “LANGUAGE”.

2 Press the Scroll buttons (  or ) until you see “PAPER 
TYPE” in the display.

3 Press Enter. The current setting is tagged with a  at the 
end of the display. 

4 Press the Scroll buttons (  or ) until you see the paper 
type you are using in the display.

5 Press Enter to save the selection.
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Loading the Original Documents

1 Open the top cover.

2 Place the document face down on the document glass. 
Position it so the horizontal and vertical edges are carefully 
aligned with the scales along the sides of the document glass.

3 Close the top cover slowly. Be careful not to move the 
document.

top corner of document
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If you want to copy or scan a book:

You can remove the top cover to place an original document such 
as a book. 

Lift the cover straight up to remove it.

To insert the cover in place, hold it as shown and insert its hinges 
into the holes. Then close the top cover.
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Copying a Document

The LCD on the operation panel displays the default copy quality 
and quantity: NORMAL 1 PAGE. You can change the default copy 
settings which will apply when copying documents using the 
corresponding buttons on the operation panel. See “Setting Copy 
Options” on page 3.7.

Follow these steps to copy using the operation panel:

1 Place the original document face down on the document glass. 
Close the top cover.

For details, see page 3.4.

2 Customize the copy settings including copy quality, contrast, 
number of copies, and copy size if necessary. See “Setting 
Copy Options” on page 3.7.

3 When you are finished setting the copy options, press Start 
Copy Black to begin a black and white copy or Start Copy  
Color for a colour copy.

NOTE: If you want cancel the copy job, press Cancel/Reset at any 
time.
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Setting Copy Options

The following buttons on the operation panel let you make all the 
basic settings: copy quality, contrast, number of copies and copy 
size. You can cancel the settings by pressing Cancel/Reset any 
time while you set the options.

Quality

To select the copy quality, use the Quality button on the operation 
panel. You can select “BEST”, “NORMAL”, or “DRAFT”. BEST mode 
is good for documents with fine details. The copy quality is good 
but the copy speed is low. NORMAL mode works well for normal 
documents (text). DRAFT mode can be used for fast copying with 
lower resolution.

To select copy quality:

1 Press Quality. The current setting is tagged with a  at the 
end of the display. 

2 Scroll through the options available by pressing Quality 

repeatedly or using the Scroll buttons (  or ).

3 When the desired mode is displayed, press Enter to save the 
selection.

NOTE: While the Paper Save mode is enabled, the print quality you 
selected through the Quality button is ignored and automatically sets 
to “NORMAL”.
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Contrast

You can adjust the contrast for a document containing faint 
markings or dark images or photographs using the Contrast 
button. You can select “LIGHTEN”, “DARKEN”, “PHOTO” or 
“NORMAL”. LIGHTEN is good for documents containing dark 
images. NORMAL works well with a standard document. DARKEN 
works well with light print or faint pencil markings. Choose PHOTO 
if you are copying a photograph. 

To select the contrast:

1 Press Contrast. The current setting is tagged with a  at the 
end of the display.

2 Scroll through the options available by pressing Contrast 

repeatedly or using the Scroll buttons (  or ). 

3 When the desired mode is displayed, press Enter to save the 
selection.

Copy page

You can select the number of copies, from 1 to 99. To change the 
number of copies:

1 Press Copy page. The current setting is tagged with a  at 
the end of the display. 

2 Change the number of copies using the Copy page button or 
Scroll buttons. 

Each time you press Copy page, the number is increased by 
1. If you press and hold Copy page, the number is increased 
in steps of 10. 

To increase or decrease the copy number by 1, use the Scroll 
buttons (  or ). If you press and hold the Scroll buttons 
(  or ), the number increases/decreases in steps of 5. 

3 When the desired quality is displayed, press Enter to save the 
selection.
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Zoom rate

You can reduce or enlarge the size of a copied image from 25% to 
400% using Zoom Rate button on the operation panel. 

To select the zoom rate from pre-defined copy sizes:

1 Press Zoom rate until the setting you want appears on the 
display.

2 Press Enter to save the selection. 

To fine-tune the size of copies:

1 Press Zoom rate until you see “CUSTOM 100% ( )” on 
the display.

2 Press the Scroll buttons (  or ) to gradually increase or 
decrease the size by 1% increments. Pressing and holding 
the Scroll buttons will change the size 5% increments.  

NOTE: While the Paper Save mode is enabled, the Zoom Rate 
you previously selected is ignored.
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Using Special Copy 

You can use the following copy features using the buttons on the 
operation panel:

• Fit to Page: Enlarges an image to fit a full page.

• Clone: Reduces or enlarges the copy image to fit to a selected 
frame size and then prints several copies of the image on the 
same page. You can also specify the number of images to be 
printed.

• Poster: Prints an image on multiple pages. Select 2x2 to print a 
4 page poster, 3x3 to print a 9 page poster or 4x4 to print a 16 
page poster. 

• Mirror: Prints the reversed image of your original document. Use 
this feature to copy favourite photos or images onto Iron-on T-
shirt transfer and then iron the transfer sheet to make a custom 
T-shirts, banners, and flags. 

• Normal: Prints in normal mode. 

NOTE: When the paper save mode is enabled any changes you made 
through the special copy does not apply even though it is accessible, 
and the print Quality sets to “NORMAL”.

Fit to Page

1 Place the document on the document glass. Close the top 
cover. See page 3.4.

2 Customize the copy settings including copy quality, contrast, 
and number of copies if necessary. See “Setting Copy Options” 
on page 3.7.

3 Press Special Copy. “FIT TO PAGE” appears in the display.

4 Press Enter.

5 Press Start Copy Black to begin black and white copying. 
To make colour copy, press Start Copy Color.

NOTE: When Fit to page is enabled, the Zoom Rate you previously 
selected is ignored.
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Clone

1 Place the document on the document glass. Close the top 
cover. See page 3.4.

2 Customize the copy quality and contrast if necessary. See 
“Setting Copy Options” on page 3.7.

3 Press Special Copy.

4 Press the Scroll buttons (  or ) until you see “CLONE” on 
the display, then press Enter.

5 Press the Scroll buttons (  or ) until you see the desired 
frame size, then press Enter. 

6 Press Copy page and select the number of images by using 

the Scroll buttons (  or ) and press Enter.

If you entered over the maximum copies described in the 
chart, remaining copies will print on another page(s)

7 Press Start Copy Black to begin black and white copying. To 
make colour copy, press Start Copy Color.

NOTE: When making a clone, the Zoom Rate you previously is ignored.

Maximum number of images on one sheet of paper:

Frame Size
Maximum Copies

 Landscape Portrait

1.5 x 2” 16 12

2.5 x 3” 9 6

3.5 x 5” 4 3

4 x 6” 1 2

5 x 7” 1 2

8 x 10” 1 1

Portrait Landscape
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Poster

1 Place the document on the document glass. Close the top 
cover. See page 3.4.

2 Customize the copy settings including copy quality, contrast, 
and number of copies if necessary. See “Setting Copy Options” 
on page 3.7.

3 Press Special Copy. “FIT TO PAGE” appears in the display.

4 Press the Scroll buttons (  or ) until you see “POSTER” on 
the display, then press Enter.

5 Press the Scroll buttons (  or ) until you see the desired 
poster size on the display. The following options are available: 
2x2, 3x3, 4x4. 

6 Press Enter to save the selection.

7 Press Start Copy Black to begin black and white copying. To 
make colour copy, press Start Copy Color.

NOTE: When printing a Poster, the Zoom Rate you previously 
selected is ignored.

Mirror

1 Place the document on the document glass. Close the top 
cover. See page 3.4.

2 Customize the copy settings including copy quality, contrast, 
number of copies, and zoom rate if necessary. See “Setting 
Copy Options” on page 3.7.

3 Press Special Copy. “FIT TO PAGE” appears in the display.

4 Press the Scroll buttons (  or ) until you see “MIRROR” on 
the display, then press Enter.

5 Press Start Copy Black to begin black and white copying. To 
make colour copy, press Start Copy Color.
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Changing Default Settings

The copy options including copy quality, contrast, number of copies 
and copy size can be set to the most frequently used modes. When 
a document is copied, the default settings will be activated unless 
otherwise changed by using the corresponding buttons on the 
operation panel.

To create your own default settings:

1 Press Setup.

2 Press the Scroll buttons (  or ) until you see 
“MAINTENANCE” on the display, then press Enter.

3 Press the Scroll buttons (  or ) until you see “DEFAULT 
SETUP” on the display, then press Enter. The first setup menu 
“CONTRAST” appears.

4 Use the Scroll buttons (  or ) to scroll through the setup 
menu available. 

5 When the desired menu appears, press Enter to access the 
menu.

6 Change settings using the Scroll buttons (  or ) and then 
press Enter to save the selection. 

7 Repeat steps 4 through 6 as necessary.

8 To return to Standby mode, press Cancel/Reset.

NOTE: When you adjust the copy settings or set special copy 
options, if you press Cancel/Reset, the settings are cancelled and 
return to their default settings.
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MEMO
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Read this chapter to learn how to select and load print 
media and how to use the print settings. 

This topics included in this chapter are:

•Paper Selection

•Loading Specialty Paper

•Printing a Document

•Printer Settings

•Using the Printer Control Program
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Paper Selection

One of the most important things you can do to assure the best 
possible printing performance of your product is to select the 
correct paper. Your product produces letter quality print on most 
plain bond paper, including cotton bond and photocopying paper; it 
does not require special ink jet paper. However, the print quality 
varies with different paper types. Be sure to test a type of paper 
before you purchase a large quantity.

Your printer supports the following types of paper. Select the right 
paper.

• Plain Paper
The product supports paper sizes of letter, legal, and A4 in 
portrait orientation. You can use regular copier paper, cotton bond 
papers, and typical letterhead. Always use paper without curls, 
folds, staples, or damaged edges.

• Coated paper
Paper developed for high quality printing with minimal or no 
smearing or running when in contact with water or damp 
surfaces.

• Glossy/Photo Paper
A high gloss, thicker paper that produces the look and feel of a 
photograph. Use this paper to produce photo-realistic prints from 
your printer.

• Transparency
Your transparencies should be products designed for use in Ink 
Jet products, with excellent contrast, sharpness, and colour 
quality.  The transparency is placed in the product with the image 
side up.

• Iron-on Transfer
Use inkjet T-shirt transfers to create and personalize T-shirts, 
sweatshirts, aprons, tablecloths, napkins, tote bags, and 
anything else your imagination allows! Use on any cotton or 
cotton/poly blend fabric. Your image is printed in mirror image so 
when you iron it onto the T-shirt, the image is viewed correctly.

• Greeting Card Stock
You can create greeting cards, business cards, invitations, 
announcements, and more.
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NOTE: When you print on these papers, you have to set the selected 
paper type in your application. See page 4.10.

Guidelines for Special Media

Be sure to read any instructions that come with your special paper. 
These instructions provide important information regarding how to 
achieve the highest print quality with these papers.

• It is recommended that you feed special paper types one sheet 
at a time.

• For transparencies and glossy photo paper, follow these 
guidelines:

• Let the printed sheets dry completely before storing them.

• When a printed sheet has dried completely, cover the printed 
   side with a sheet of plain (not coated) paper before storing it, 
   this is recommended even if you place the sheets in a clear file 
   or plastic holder.

• Do not leave the film in the paper output tray for long periods 
   of time. Dust and dirt may accumulate on the film resulting in 
   spotty printing.

• To avoid smudging caused by fingerprints, handle transparency 
   film and coated paper carefully.

• To avoid fading, do not expose the printed film to prolonged 
   sunlight. 

• Store unused media flat. Do not remove papers from their 
protective packaging until you are ready to use them.

Select the
paper type
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• Store unused media at temperatures between 59 and 86 oF 
(15 to 30 oC). The relative humidity should be between 10% and 
70%.

• If the print density of your page is very high, light paper stock 
may curl slightly due to the large amount of ink. If you need to 
print dense graphics, try printing on heavier stock.

• Do not use thicker paper than meets the specifications for this 
product. Printing with a paper that is thick enough to come in 
contact with the print head nozzles may damage the cartridge.

Loading Specialty Paper

Follow these guidelines when loading specialty paper:

Load up to: And make sure:

100 sheets of  
plain paper 
(depending on 
thickness)

• The print side is facing you.

• The paper is against the right side of the paper support.

10 envelopes • The print side is facing you.

• The envelopes are loaded vertically 
against the right side of the paper 
support.

• The stamp location is in the upper 
left corner.

• The paper guide rests against the edge of the envelopes.

10 greeting cards, 
index cards, 
postcards, or 
photo cards

• The print side is facing you.

• The cards are loaded vertically against the right side of the 
paper support.

• The paper guide rests against the edge of the cards.

25 sheets of 
photo paper

• The glossy or coated side is facing you.

• The paper guide rests against the edge of the photo paper.
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Paper Guidelines
• When loading paper, envelopes, or other special media, keep 

these guidelines in mind:

• Attempting to print on damp, curled, wrinkled, or torn paper can 
cause paper jams and poor print quality.

• Use only high quality inkjet or copier grade paper. Avoid paper 
with embossed lettering, perforations, or texture that is too 
smooth or too rough.

• Store paper in its ream wrapper until ready to use. Place cartons 
on pallets or shelves, not on the floor. Do not place heavy objects 
on top of the paper, whether it is packaged or unpackaged. Keep 
it away from moisture, or other conditions that can cause it to 
wrinkle or curl.

• During storage, moisture-proof wrap (any plastic container or 
bag) should be used to prevent dust and moisture from 
contaminating your paper.

• Always use paper and other media that conform with those listed 
under Specifications on page 8.4.

• Use only well-constructed envelopes with sharp, well creased 
folds.

• DO NOT use envelopes with clasps and snaps.

• DO NOT use envelopes with windows, coated linings, self-
adhesive seals, or other synthetic materials.

• DO NOT use damaged or poorly made envelopes.

10 transparencies • The rough sides of the transparencies are facing you.

• The paper guide rests against the edge of the transparencies.

100 sheets of 
custom size paper 

• The print side is facing you.

• Your paper size fits within these dimensions:
- Width: 76 mm to 216 mm (3.0 in. to 8.5 in.)
- Length: 127 mm to 432 mm (5.0 in. to 17.0 in.)

• The paper guide rests against the edge of the paper

25 iron-on 
transfers

• You follow the loading instructions on the iron-on packaging.

• The print side (blank side) is facing you.

• The paper guide rests against the edge of the iron-on 
transfers.

Load up to: And make sure:
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Printing a Document

This procedure describes the general steps required for printing 
from various Windows applications. The exact steps for printing a 
document may vary depending on the application program you are 
using. Refer to your software application’s documentation for the 
exact printing procedure.

 The following steps describe the typical process to print from a 
Windows environment:

1 Ensure that your Samsung SCX-1100 is properly connected to 
the computer, the product is powered on, and there is paper in 
the paper bin.

2 Verify that you have installed the Samsung software for your 
computer. For details, see “Installing Samsung Software” on 
page 2.4.

3 Start the program you are using to create the document, and 
create or open the document you want to print. 

4 Choose Print or Print Setup from the File menu. Make sure 
that Samsung SCX-1100 Series is selected as your default 
printer. Click Properties or Setup if you want to make any 
adjustments that are appropriate for printing your document. 
(For details, see “Printer Settings” on page 4.8.)

5 Click OK to close the Properties dialog box.
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6 After making any necessary changes to the printing 
parameters, click OK to start the print job.

After a moment, Samsung SCX-1100 Series Control Program 
window appears. You can cancel the print job as well as 
seeing how much ink you have left and view printing tips in 
this window.

For Windows 2000/XP, the Control Program does not appear. 
Right-click on the printer icon on the taskbar at the bottom 
right corner of the desktop window. From the pop-up menu, 
you can select commands to cancel, pause, or resume 
printing.

NOTE: If you want to use another printer instead of SCX-1100, you 
must disable the scan monitor on the taskbar at the bottom right 
corner of the desktop window. The scan monitor is enabled as long as 
SCX-1100 is connected to your computer and turned on. To disable 
the scan monitor, right-click on the scan monitor and select Disable 
from the pop-up menu.

in case of Windows 98. The appearance of this window may 
be different depending on your Windows operation system.
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Printer Settings

You can use the product with all your Windows 95/98/Me/2000/XP 
or Windows NT 4.0 applications. Be sure to set Samsung SCX-1100 
Series as the default printer for all you Windows operations.

Most Windows software applications allow you to make changes to 
the printer settings. This includes settings that determine how a 
print job looks such as paper size, paper orientation, and margins. 
Settings made in the application to create the document will usually 
override settings made in the printer driver.

NOTE: You do not need to use any of the front panel buttons to use 
the product as a PC printer. For example, if you want to adjust the 
printing contrast you do not have to press Contrast on the operation 
panel. The operation panel buttons are used primarily for copying.

Accessing Printer Settings

You can access printer settings by using either of these methods.

Windows 95/98/Me

• Select the File > Print > Properties or File > Print Setup 
command from  within any Windows application.

Or

• Select Samsung SCX-1100 Series printer from the Printers 
folder, then select File > Properties (or select the printer icon in 
the Printers folder, and click the right mouse button).

Windows NT 4.0

• Select the File > Print > Properties or File > Print Setup 
command from  within any Windows application.

Or

• Select Samsung SCX-1100 Series printer from the Printers 
folder, click the right mouse button, then select Document 
Defaults from the drop-down list.
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Windows 2000/XP

• Select the File > Print > Properties or File > Print Setup 
command from  within any Windows application.

Or

• Select Samsung SCX-1100 Series printer from the Printers 
folder, click the right mouse button, then select Printing 
Preferences from the drop-down list.

Printer Properties Tabs (Windows 95/98/Me)

When the Printer Properties are displayed, you can review and 
change whatever settings are needed for your printer job.

Your printer’s Properties window consists of  4 tabs: Paper, 
Quality, Job Finishing and Advanced.

If you access the Printer Properties through the Printers folder, 
you can view more Windows-based tabs, as well as these 4 tabs. 
For information on the Windows-based tabs, refer to your Windows 
User Guide.

NOTE: If you access the Printer Properties through the Printers 
folder, any settings made will become the default settings for the 
printer. Settings made when the Printer Properties are accessed 
through an application File menu and Print or Print Setup will 
remain active until the application you are printing from is closed.
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Paper Tab 

Use the Paper tab to select what size of paper you have in your 
printer, the orientation, the number of copies to print, etc.

Document/Quality Tab

The Document/Quality tab controls the document type, the 
paper type, such as plain, coated, and glossy. It also controls the 
quality (resolution) of the printing. Higher resolutions print better, 
but take longer and consume more ink. Selecting Web Smoothing 
allows you to print clearer images from the Internet.

Select the paper size you have 
loaded in your printer. If you 
have a special size of paper to 
print on, select Custom and 
define its size in the custom 
settings. The minimum paper 
size you can use is 3 by 5 inches. 
The maximum size is 8.5 by 17 
inches.

Resets to the default settings.

Shows the printer driver 
version.
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Job Finishing Tab

The Job Finishing tab provides options for you to adjust how the 
document will appear on the printed page. Job Finishing options 
can include Poster, Handout, Booklet and Two-sided printing.

Booklet

The Booklet option allows you to print a document out as a booklet. 
If the Print reloading instructions after the first side prints is 
checked, a page will print directing you how to insert the paper so 
that the booklet prints correctly.

A bundle is any number of sheets 
of paper folded together. When 
printing with a heavier paper 
stock, select a smaller number of 
Sheets Per Bundle.
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Once your document prints, stack the bundles and bind the booklet.

1 Take the first bundle from the paper output 
tray, fold it in half, and set it aside.

2 Fold and stack the rest of your bundles, one 
on top of the other, until your booklet is 
complete.

3 Bind the bundles.

Poster

Choose the Poster option to enlarge the printed document. If you 
check Show Crop Marks, the image will print with crop marks. The 
white space around the image can be easily trimmed.
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Handout

Choose the Handout option to print multiple pages on a single 
sheet of paper.

Two-Sided Printing

Choose the Two-sided printing option from the Job Finishing 
tab to print the document on both sides of the paper.
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Advanced Tab

The Advanced tab allows you to change how the printer handles 
colour printing. You should rarely need to change these settings.

Printer Properties Tabs (Windows NT 4.0)

Page Setup Tab

This tab allows you to set page properties including number of 
copies, collate, print quality, orientation, reverse order printing, 
paper size, and paper type.
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Color Tab

Use the Color tab for optimising the graphic and colour print job. 
You can adjust halftone shading, brightness and contrast. You can 
also select the colour appearance and the document colour. 

Feature Tab

You can select the Dry Time Delay option and the two-sided 
printing option. You can also access Cartridge Maintenance 
features from this tab.

NOTE: In Windows NT 4.0, Poster, Handout, and Booklet printing are 
not provided.
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Printer Properties Tabs (Windows 2000/XP)

Paper Quality Tab

This tab allows you to select paper source, paper type, print quality, 
and colour. The Advanced button under this tab allows you to 
select advanced document settings including paper size, print 
resolution, and colour intent. 

Layout Tab

Use the Layout tab to select print orientation, and page order. 
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Printer Properties Buttons & Icons
• Click OK when done reviewing or making changes.

• Click Cancel if you want to exit the tab menus without applying 
any changes.

• Click Help to view the online Help feature and tab menu details.

• Click the ? icon in the title bar. Position the ? pointer over the 
parameter in question and click to see a pop up window 
explaining that parameter.

Using the Printer Control Program

The SCX-1100 Series Control Program contains setup options that 
define the operation of your product.

NOTE: The Printer Control Program is not available in Windows 
2000/XP.

Accessing Printer Control Program

1 Click Start > Programs> SAMSUNG SCX-1100 Series> 
Printer Control Program.

NOTE: Windows NT 4.0 users can also access the Printer Control 
Program from the Printer Properties window. See page 4.14.

2 The Samsung SCX-1100 Series Control Program window 
appears. The appearance of the window may be different from 
the ones below depending on your Windows operating 
system. Click the appropriate tab for the options you want to 
display, and make the necessary changes on each tab.

NOTE: Click Help on any tab in the Control Program window to 
access on-line Help.
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Status Tab

The Status tab gives you general status information on the printer. 
You will see this window when the printer is printing (unless you’ve 
set the Control Program Options to Run Minimized, using the 
options on page 4.19).

Once a print job has started, you can use this window to cancel the 
print job or monitor the job progress.

The ink level of your cartridges is also displayed. Use the gauges to 
help you determine when they need replacing.

NT 4.0 provides 
this button in the 
Cartridge tab.

in case of Windows 98
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Options Tab

From the Options tab, you can control some of the behaviour of 
the Control Program. The options available will vary depending on 
your Windows operating system. Some of the options activate 
under a specific printing environment such as network printing. 
Click Help for further information.

in case of Windows 98
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Cartridges Tab

The Cartridges tab gives you access to several different cartridge 
functions. From here, you can install new cartridges, change them, 
clean your print nozzles, align your cartridges, or order supplies 
from the internet.

NOTE: If you are using either Windows 2000 or XP, you can access to 
the Cartridge Maintenance tab through printer’s properties of the 
Samsung SCX-1100 series.

About Tab

The About tab gives you the program version number. If you click 
on the globe image on the bottom of the window, you will be 
connected to the Samsung web site provided you are an internet 
user.

in case of Windows 98

Not available in
Windows NT 4.0.
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Scanning with the Samsung SCX-1100 lets you turn 
pictures and text into digital files on your computer. Then 
you can fax or e-mail the files, display them on your web 
site, or use them to create projects that you can print out 
using Samsung SmarThru software which came with your 
product.

This chapter includes:

•Scanning Basics

•Starting Scan from the Operation Panel

•Scanning Process with TWAIN-enabled Software
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Scanning Basics

Your SCX-1100 offers three ways to start scanning. These include:

• From the Samsung SmarThru software: Launch Samsung 
SmarThru and open the Scan Wizard to start scanning. Please 
refer to the SmarThru User’s Guide.

• From the operation panel on your product: Use the Scan to 
button on the operation panel to initiate scanning. SmarThru 
system launches automatically and the Scan Wizard window 
opens on the desktop window.

• From TWAIN-compliant software: You can use other software 
including Adobe PhotoDeluxe and Adobe Photoshop. 

NOTES:
• To scan with your product, you must install the MFP driver. 
• Scanning is made through the same LPT or USB port which is 

currently assigned for your printer port. 

Starting Scan from the Operation Panel

You can quickly start scanning from the operation panel on your 
product. The Samsung SmarThru program automatically launches 
and allows you to select the desired scan service. Take the following 
steps:

1 Make sure that your computer and SCX-1100 are turned on. 
You will see the scan monitor icon on the taskbar at the 
bottom right corner of the desktop window unless you disable 
or turn off the scan monitor.

Scan monitor
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2 Place the original document you want to scan face down on 
the document glass. Position it so the horizontal and vertical 
edges are carefully aligned with the scales on the sides of the 
document glass. Then close the top cover.

3 Press Scan to on the operation panel.

NOTE: If you press Scan to when the scan monitor on the desktop 
window is disabled or turned off (see page 5.2), “PC NOT AVAILABLE” 
appears on the display and you cannot achieve scanning.
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4 The Samsung SmarThru launches automatically and the Scan 
Wizard window opens.

The Scan Wizard lets you use the following services:

• Scan
Lets you scan the original documents and save them in the 
Image Manager of the Samsung SmarThru system. The 
Image Manager is an image database manager and image 
editor program. 

• Copy
Lets you use your product to produce professional quality 
copies. You can adjust the image size and make advanced 
settings.

• Scan to Email
Lets you scan the original document then launches a New 
Message form to send the just scanned image attached to a 
new mail. The email account must be configured in the 
Samsung SmarThru system to enable e-mail service. 

• Scan to FAX
Lets you scan the original documents then launches a New 
Fax form which helps you send them as a fax image.

• Scan to WEB
Lets you scan the original documents for further publishing 
to the Web.
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• Scan to OCR
Lets you scan the original documents and pass them to the 
OCR program. OCR (Optical Character Recognition) is the 
process of converting a scanned image into text that you 
can edit in a word processing program. After you scan your 
document, the software processes or “recognizes” it. Then 
you can edit it and either save the file or open it in any word 
processing program on your computer.

5 Click the desired service.

6 The Samsung Scan Manager for the selected service opens. 
Adjust the scan settings. You can use the Help button to get 
on-line help. 

7 To start scanning, click Scan. 

For further information, please refer to the SmarThru User’s 
Guide which came with your product.

NOTE: If you want cancel the scan job, press Cancel/Reset at any 
time.
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Scanning Process with TWAIN-enabled 
Software 

If you want to scan documents using another software, you will 
have to use TWAIN-compliant software such as Adobe PhotoDeluxe 
or Adobe Photoshop. The first time you scan with your SCX-1100, 
you will need to select it as your TWAIN source on the application 
you will use. 

The basic scanning process involves a number of steps:

• Placing your photo or page on the document glass.

• Opening an application (such as PhotoDeluxe or Photoshop).  

• Opening the TWAIN window and setting scan options.

• Scanning and saving your scanned image.

You have to follow the program’s instructions for acquiring an 
image. Please refer to the application user’s guide.



6 MAINTENANCE

This chapter provides suggestions for high-quality and 
economical printing and information for maintaining the 
print cartridge and your product. 

This chapter includes:

•Maintaining Print Cartridges

•Viewing Ink Level

•Cleaning Print Cartridges

•Replacing Print Cartridges

•Aligning Print Cartridges

•When the procedure is finished, click OK.

•Cleaning Document Glass

•Using Help List
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Maintaining Print Cartridges  

To get the maximum benefit from your print cartridges:

• Do not remove a print cartridge from its packaging until you are 
ready to install it.

• Do not refill the print cartridges. The warranty does not cover 
damage caused by using refilled cartridges.

• Store the print cartridges in the same environment as your 
product.

• Do not remove a print cartridge from the product except to 
replace, or clean. Immediately replace the print cartridge or store 
in the storage unit. The print cartridge will not print correctly if 
removed from the product and left exposed for an extended 
period of time.

• Your product will not print with only one print cartridge installed. 
If you do not have a new replacement for the empty print 
cartridge, leave the empty cartridge in the cartridge holder of the 
product.

• Do not swap the colour cartridge with the black cartridge. The 
colour cartridge should be installed in the Left carrier and the 
black cartridge should be installed in the Right carrier.

• If you have an opened ink cartridge you are not currently using 
and do not have an available print cartridge storage unit, store it 
in an airtight plastic bag. Do not leave it exposed to air for an 
extended period; this promotes drying out and clogging of the 
print nozzles.
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Viewing Ink Level

You can view the ink level on the LCD display using the operation 
panel buttons. Take the following steps:

1 Press Setup on the operation panel.

2 Press the Scroll buttons (  or ) until you see 
“MAINTENANCE” on the display, then press Enter.

3 Press the Scroll buttons (  or ) until you see “VIEW INK 
LEVEL” on the display, then press Enter.

4 The colour ink level and the black ink level are displayed 
alternatively on the display. The remaining ink capacity of the 
maximum capacity displays.

5 Press Cancel/Reset to return to Standby mode.

Cleaning Print Cartridges

Cleaning your print cartridges can improve the quality of printing. 
If your printed page is missing lines or dots or contains ink streaks, 
clean the print cartridges as described below.

There are two methods to clean the print cartridges:

• Print a head cleaning page, which can be done from the operation 
panel of your product or from the Control Program on your 
computer screen.

• Clean the print cartridge nozzles.

NOTE: Do not clean the print cartridges unnecessarily, as this wastes 
ink and shortens the life of the print cartridge.
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Printing a Cleaning Page from the Product 

1 Press Setup on the operation panel.

2 Press the Scroll buttons (  or ) until you see 
“MAINTENANCE” on the display.

3 Press Enter. “CLEAN CARTRIDGE” appears in the display. 

4 Press Enter to start the cleaning process. Your product prints 
a cartridge clean page.

5 Examine the cleaning pattern. Compare the diagonal lines at 
the top and bottom of the test pattern.  

A broken line shows any clogged nozzles. If the bottom line 
shows improvement, rerun this cleaning process two more 
times.

 If this process does not improve the print quality, your print 
cartridges may be low in ink. Replace the print cartridge, if 
necessary.

6 If the line is still broken, clean the print nozzles. See 
“Cleaning Print Cartridge Nozzles” on page 6.6.

Before purge

Purge process

After purge
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Printing a Cleaning Page from Your Computer

1 Click Start  > Programs > Samsung SCX-1100 Series > 
Printer Control Program. 

2 The Samsung SCX-1100 Series window appears. Select the 
Cartridges tab.

3 Click Clean Print Nozzles.

4 The product feeds a sheet of paper and prints a cleaning 
pattern. Examine the cleaning pattern. Refer to step 5 under 
“Printing a Cleaning Page from the Product” on page 6.4.

NOTE: If you are using either Windows 2000 or XP, you can access 
to the Cartridge Maintenance tab through printer’s properties of 
the Samsung SCX-1100 series.

in case of Windows 98
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Cleaning Print Cartridge Nozzles

If print quality does not improve after repeatedly printing the 
cleaning page, the problem may be caused by dried ink on the print 
cartridges.

1 Open the cartridge door by grabbing the door handle at the 
top edge.

2 Remove the print cartridges. For details, refer to step 3 under 
“Replacing Print Cartridges" on page 6.11.

NOTES:
• Keep new and used print cartridges out of the reach of children.
• Once you have removed the print cartridges, ensure that they  are 

not out of the printer longer than 30 minutes.
• Be careful not to touch the ink nozzles or the electrical contacts. 

Touching these parts of the print cartridge can result in clogs, ink 
failure, or a bad electrical connection.
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3 Use a clean cloth, dampened with water only, to gently clean 
the entire copper coloured area, including the nozzles and 
contacts.

To dissolve any dried ink, place the cartridge on a heavy damp 
cloth as shown below and push the cartridge with light 
pressure to let the nozzles in contact with the cloth for about 
three seconds. Then gently blot and wipe dry.

If you are cleaning a colour print cartridge, be especially 
careful to wipe the nozzles in only one direction so the colours 
do not mix.

4 Allow the copper-coloured area to dry.

5 Reinstall the print cartridges and close the cartridge door. 
The display prompts you to confirm “NONE CHANGED?”. 
Press Enter. The display returns to Standby mode. 

6 Print a cleaning page and examine the cleaning pattern by 
following the instructions on page 6.3. If the line is still 
broken, clean the print cartridge holder contacts in your 
product.

NOTE: Once the cartridges are removed and installed, cartridge 
alignment may be required. After you clean the cartridge, if 
necessary, align the cartridges.

Nozzles

Contact area
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Cleaning Cartridge Holder Contacts

1 Open the cartridge door by grabbing the door handle at the 
top edge.

2 After the print cartridges have moved to the centre of the 
product, unplug the power cord to turn the power off with the 
cartridge holder in the centre.

3 Remove the print cartridges. For details, refer to step 3 under 
“Replacing Print Cartridges” on page 6.11.
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4 Use a CLEAN, DRY CLOTH to clean the print cartridge contacts 
inside the printer.

5 Reinstall the print cartridges, then close the cartridge door. 

6 Plug the power cord back to the AC outlet. 

Replacing Print Cartridges

Your product is a dual cartridge inkjet printer. You must use a 
colour and a black (or photo) ink cartridge.

There are two types in the black and the colour cartridge by the 
yield: Standard and High yield. Before proceeding to install, you 
need to check which cartridge type you have. When you install the 
cartridges, you will be asked if it is Standard or High Yield. To find 
out the type, refer to the table below.

Please contact your nearest dealer for the following print 
cartridges:

Cartridge contact

Cartridge type Part number

Black cartridge

High yield Lexmark 12A1975

Standard Samsung INK-M50 
Lexmark 12A1970

colour cartridge

High yield Lexmark 15M0125

Standard Samsung INK-C60 
Lexmark 15M0120

Photo cartridge Lexmark 12A1990
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When you notice the print becomes light or “INK LOW” appears in 
the display, replace the appropriate cartridge(s).

The print cartridge includes the ink supply and the print head. Each 
time you replace the ink cartridge you are replacing the print head 
as well.

Replacement of the print cartridges can be done from the operation 
panel of your product or from the computer using the Samsung 
SCX-1100 Series Control Program.

Replacing Print Cartridges from the Product

1 Carefully unwrap the new ink cartridge(s) and remove the 
sealing tape. Slowly pull straight out.

2 Open the cartridge door by grabbing the door handle on the 
top edge. The print cartridge carrier moves to the centre 
position of the product.
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3 Locate the print cartridge holder inside the product. The black 
ink cartridge holder is located on the right side of the 
cartridge holder and the colour ink cartridge is located on the 
left side.

4 Pull the old cartridge(s) toward you until you hear a click and 
then remove the cartridge(s) from the holder.

5 Place the new print cartridges into the holder and push it until 
it clicks into place.

NOTE: Avoid touching the electrical contacts on the cartridge. Ensure 
that there are no pieces of tape remaining on the cartridge.

6 Close the cartridge door. The display prompts you to confirm 
which cartridge(s) to be changed.

7 You can choose from “NONE CHANGED?”, “LEFT CHANGED?”, 
“RIGHT CHANGED?” or “BOTH CHANGED?” by using the 
Scroll buttons (  or ). Press Enter when your choice 
appears in the display.

Colour ink cartridge

Black ink cartridge
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8 The display asks if you have installed a new cartridge. Press 
Enter when you have installed a new cartridge. If you have 
installed a photo cartridge or an old cartridge, press the 
Scroll buttons (  or ) until you see your choice in the 
display and then press Enter. 

9 If you have selected “NEW COLOR”, “NEW BLACK”, or “NEW 
PHOTO”, the display asks if you have installed a standard 
capacity cartridge. 

10 Press Enter if you have installed a standard capacity 
cartridge. If you have installed a high yield capacity cartridge, 
press the Scroll buttons (  or ) until you see your choice 
in the display and press Enter. 

NOTE: If you make a mistake when confirming the cartridge 
capacity, the ink level shown in the Printer Control Program may not 
be correct.

11 If you have selected “BOTH CHANGED?” at step 7, you will be 
guided to set the black (or photo) cartridge after you finish 
setting the colour cartridge. 

12 If you installed a new cartridge, the cartridge alignment 
procedure begins automatically by printing the Alignment 
Cartridge form. Refer to step 4 under “Aligning the Print 
Cartridges” on page 6.14.

If you installed an old cartridge, the product returns to 
Standby mode without printing the Alignment Cartridge form.

NOTE: If you reinstall the printer driver, the ink level on the Printer 
Control Program may be not correct even when you do not change 
the cartridges.
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Replacing Print Cartridges from the Computer

1 Click Start > Programs > Samsung SCX-1100 Series > 
Printer Control Program. You have accessed the Samsung 
SCX-1100 Series Control Program.

2 Select the Cartridges tab. Click Install/Change Cartridge. 

3 Open the cartridge door and replace the old cartridge(s) by 
following the instructions on page 6.10.

4 When you finish installing cartridge(s), click the appropriate 
buttons in the Samsung SCX-1100 Series dialog box to 
confirm the type of the cartridges you have installed.

5 When you finish, click OK. If you have installed one or both 
cartridges as new, the message dialog box appears to prompt 
you to align the cartridge. Click Align.

6 Your product prints the Cartridge Alignment form. Complete 
the alignment procedure by following the instructions on the 
page 6.16.

If you installed an old cartridge(s), the product returns to 
Standby mode without printing the Cartridge Alignment form. 

NOTE: If you are using either Windows 2000 or XP, you can access 
to the Cartridge Maintenance tab through printer’s properties of 
the Samsung SCX-1100 series.

in case of Windows 98



6.14 Maintenance

Aligning Print Cartridges 

You must align the black and colour print cartridges after installing 
a new print cartridge or if the black portions of graphics do not align 
with the colour portions.

Cartridge alignment can be done from the computer using the 
Samsung SCX-1100 Series Control Program or from the operation 
panel of your product.

Aligning Print Cartridges from the Product

1 Press Setup on the operation panel.

2 Press the Scroll buttons (  or ) until you see 
“MAINTENANCE” on the display, then press Enter.

3 Press the Scroll buttons (  or ) until you see “ALIGN 
CARTRIDGE” on the display, then press Enter to start 
cartridge alignment.

4 The product feeds a sheet of paper and prints the Cartridge 
Alignment form. 
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5 From each group on the form, locate the number under the 
alignment pattern that comes closest to forming a perfectly 
straight line. 

6 The alignment entry menu appears on the display. The letter 
on the right end of the display corresponds to the alignment 
pattern. The range of numbers in the centre of the display 
indicates the range of valid selection choices. The flashing 
number on the left side of the display indicates the line from 
the form that is currently selected as optimal.

7 Using the Scroll buttons (  or ), enter the number of the 
line which appears the straightest from pattern A. 

Press Enter to confirm your selection. The alignment entry 
menu for the Alignment B pattern is displayed.

8 Repeat step 6 for Alignment patterns B through F (or D for 
colour and photo cartridges).

9 After you enter the number for the last group, Alignment F (or 
D for colour and photo cartridges), the display automatically 
returns to the Standby mode.

Aligning Print Cartridges from the Computer

1 Start Windows, if not already started.

2 Click Start > Programs > Samsung SCX-1100 Series > 
Printer Control Program. You have accessed the Samsung 
SCX-1100 Series Control program. 

3 Select the Cartridges tab.

4 Click Align Cartridges.

Last Alignment
Entry

Number Range Alignments 
(A, B, C, D, E, F)
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5 The product feeds a sheet of paper and prints the Alignment 
Cartridge form. The Align Cartridges dialog box appears.

6 Locate the number under each alignment group in the pattern 
that comes closest to forming a perfect straight line. Then 
enter the number of the line or click repeatedly the  or  
key to select the number.

7 When the procedure is finished, click OK.
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Cleaning Document Glass  

To keep your product working properly, occasionally clean the 
document glass.

Clean the document glass with a soft cloth. Do not spray the 
cleaner directly onto the document glass. Always spray the cleaner 
onto the cloth.

Using Help List

1 Press Setup on the operation panel.

2 Press the Scroll buttons (  or ) until you see 
“MAINTENANCE” on the display, then press Enter.

3 Press the Scroll buttons (  or ) until you see “HELP LIST” 
on the display, then press Enter.

Document Glass
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MEMO



7 TROUBLESHOOTING

This chapter gives helpful information for what to do if you 
encounter an error. 

This chapter includes:

•Clearing Paper Jams

•LCD Error Messages

•Fixing Problems



7.2 Troubleshooting

Clearing Paper Jams

If paper jams occur, “REMOVE PAPER JAM” and “PRESS CANCEL” 
displays alternatively. Follow the steps below to clear the jam. To 
avoid tearing paper, pull the jammed paper out gently and slowly.

If jammed in the paper feed area at the rear of the product:

1 Remove the stack of paper (if necessary).

2 Remove the jammed paper by gently pulling it straight up.

3 After you remove the jammed paper, reload the stack of paper 
back into the paper bin with the print side facing you. Before 
loading, ensure the edges of the stack of paper are even and 
straight.

4 Adjust the paper guide to match the width of the paper.
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5 If the paper jams as it exits to the paper output tray, remove 
the jammed paper by pulling gently on the paper.

6 Press Cancel/Reset to clear the error message on the 
display.

NOTE: If there is any resistance, and the paper does not move 
immediately when you pull, open the cartridge door and gently pull 
the jammed paper out of the printer.
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Tips for Avoiding Paper Jams

By carefully selecting print materials and loading them properly, 
you should be able to avoid most paper jams. If jams do occur, 
follow the steps outlined in “Clearing Paper Jams” starting on page 
7.2. If jams occur frequently, make sure that you are following 
these preventative tips:

• Follow the procedures in “Loading Paper” on page 1.10 to load 
paper properly. Make sure that the adjustable guides are 
positioned correctly.

• Do not overload the paper. Up to 100 sheets can be loaded in the 
paper bin at a time.

• Envelopes with self-stick adhesives may cause wrinkling, 
creasing, or even jams and may even damage your product.

• Fan stacks of labels or transparencies before loading them into 
the paper input bin. If jams occur, try feeding one sheet at a time.

• Do not load wrinkled, creased, damp, or highly curled paper.

• Do not mix paper sizes in the paper input bin.

• Use only recommended print media. 

• Make sure that the recommended print side is facing up when 
loading it in the paper input bin.

• Keep print media stored in a suitable environment.
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LCD Error Messages

LCD Display Meaning Solution

COLOR INK LOW
BLACK INK LOW
PHOTO INK LOW
ALL INK LOW

The indicated ink 
cartridge is low or out 
of ink.

Install a new ink cartridge.

COVER OPEN The cartridge door is 
not securely latched.

Press down on the cartridge door 
until it clicks in place.

REMOVE PAPER JAM 
PRESS CANCEL

Paper jammed while 
printing.

Clear the jam. Refer to “Clearing 
Paper Jams” on page 7.2.

SYSTEM ERROR Internal system errors 
detected.

Look for obvious error conditions. If 
the problem persists, power the 
product off and on. Contact the 
nearest dealer.

ADD PAPER
PRESS ENTER

The paper bin is 
empty.

If the product runs out of paper 
while printing, it will restart 
printing when more paper is 
loaded. Press Enter after loading 
paper.

SYSTEM BUSY You have tried to use 
the system when it is 
currently in use.

Wait for the current job to 
complete, then try again.

SCAN MOTOR STALL LCD Scan Motor is 
stalled.

Turn the power off then back on.

NOT SUPPORTED IF 
YOU WANT COLOR 
COPY WITHOUT 
PAPER SAVE, PLEASE 
PRESS ENTER OR 
COLOR COPY KEY.

You tried to make a 
colour copy when the 
paper save mode is 
activated.

You cannot make a colour copy with 
the paper save mode activated. To 
temporarily disable the paper save, 
press Enter or Start Copy Color.

NOT SUPPORTED 
THE ORIGINAL 
DOCUMENT IS SO 
BIG, PLEASE 
CHANGE CLONE 
SIZE OVER 1.5X2” 
AND RESTART.

You placed a too big 
original to fit into 
1.5X2”.

Change the Clone frame size bigger 
than 1.5X2”.
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Fixing Problems

Paper Feeding Problems

Symptom Cause and Solution

Paper is jammed 
during printing.

Clear the paper jam. See page 7.2.

Paper sticks together. • Ensure there is not too much paper in the paper bin. 
Depending on the thickness of your paper, the paper bin 
can hold up to 100 sheets of paper.

• Make sure you are using the correct type of paper. See 
“Paper Selection” on page 4.2.

• Remove paper from the paper bin and flex or fan the 
paper.

• Humid conditions may cause some paper to stick together.

Paper fails to feed. • Remove any obstructions inside the product.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the paper bin. 
Load the paper of only one type, size, and weight.

• When loading paper, do not force the paper down into the 
printer.

• If multiple sheets have caused a paper jam, clear the 
paper jam. See page 7.2.

Paper skews or 
buckles

• Ensure there is not too much paper in the paper bin. 
Depending on the thickness of your paper, the paper bin 
can hold up to 100 sheets of paper.

• Make sure the paper guide does not cause the paper to 
bow in the paper bin.

• Make sure you are using the correct type of paper. See 
“Paper Selection” on page 4.2.

• When loading paper, do not force the paper down into the 
product.

• Make sure the right side of the paper is aligned with the 
right edge of the paper bin, and the left paper guide is set 
against the left side of the paper.
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General Printing Problems

Transparencies stick 
together in the paper 
exit.

Use only the transparencies specially designed for an ink jet 
printer. Remove each transparency as it exits from the 
printer.

Envelopes skew or fail 
to feed correctly.

Ensure that the paper guide is against the left side of the 
envelopes.

Symptom Cause and Solution

Your product does not 
print.

• The printer cable is not connected properly. Check the 
printer cable connection.

• The printer cable is defective. Swap the cable with one 
known to work. 

• The port setting is incorrect. Check the Windows printer 
settings to make sure that the print job is being sent to 
the correct port (for example, LPT1).

• You have unplugged the USB cable from your computer 
then plugged back to a different USB port than you have 
used before. In this case, your printer driver creates a 
virtual printer in the Printer folder on your computer 
system each time you use another different port. You 
have to remove the newly created virtual printer(s). To 
remove:
1. Open the Printer folder and right-click on the last 
    created Samsung SCX-1100 Series Copy x (where x
    is the number of the created virtual printers).
2. Select Properties from the pop-up menu and then 
    click Ports tab.
3. Locate the USB port which is checked and then close 
    the Printer folder.
4. Reopen the Printer folder.
5. Right-click on the original printer Samsung SCX-1100 
    Series.
6. Select Properties from the pop-up menu and then 
    click Ports tab.
7. Put a checkmark in the checkbox of the USB port you 
    have found at step 3.
8. Remove the Samsung SCX-1100 Series Copy x from
    the Printer folder.

• The print cartridge is not installed properly. Remove and 
reinsert the print cartridge.

Symptom Cause and Solution
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Your product does not 
print. (continued)

• The printer properties may be configured incorrectly. 
Check the application to make sure that all print settings 
are correct.

• The printer driver may be incorrectly installed. Uninstall 
the MFP driver and reinstall the MFP driver. Then try 
printing a test page. Refer to “Uninstalling Samsung 
Software” on page 2.12.

• A paper jam has occurred. Remove the jammed paper. 
See page 7.2.

• If a file sent from Acrobat Reader 4.0 does not print or 
print improperly, from the Acrobat Reader File menu, 
select Print and check the Print as image box. If it 
doesn’t solve the problem, upgrade Acrobat Reader to 5.0 
or higher.

• For Windows 2000/XP, if you remove the product from the 
PC and then connect back to the PC, the printer might be 
set to Off line status. Open the Windows Printer folder and 
check if the SCX-1100 is off line. If so, right-click on SCX-
1100 Series printer and deselect Use Printer Offline. 

The paper is not feed 
into the product.

• Paper has not been inserted correctly. Remove and 
reinsert the paper correctly (refer to “Loading Paper” on 
page 1.10).

• There is too much paper in the paper bin. Remove some 
of the paper from the paper bin.

The paper keeps 
jamming.

• There is too much paper in the paper bin. Remove some 
of the paper from the paper bin. (If printing onto 
transparencies, or labels, insert them one at a time.)

• The paper setting method may be incorrect. If printing 
onto envelopes, insert the envelopes so that there is a 
gap of approximately 1 mm (1/32”) between the left and 
right edge of the envelopes at the paper guide.

Symptom Cause and Solution
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Part of the printed 
page is blank.

• The page layout is too complex. Simplify the page layout 
and remove any unnecessary graphics from the document 
if possible.

• The page orientation setting may be incorrect. Change the 
page orientation in the Printer Properties dialogue box.

• The paper size and the software paper size settings do not 
match. Insert the correct paper into the product or 
change the software paper size settings.

• Scaling may be set to less than 100%. Change the Scaling 
setting in the Printer Properties dialogue box.

• If using a parallel cable, ensure that it is compliant with 
an IEEE-1284 rated cable.

Your product prints 
the wrong data, or it 
prints incorrect 
characters.

• The printer cable might not be connected properly. Check 
the printer cable connection.

• There may be a problem with the printer driver software. 
Exit Windows and reboot the computer. Turn the printer 
off and then back on again.

• If using a parallel cable, ensure that it is compliant with 
an IEEE-1284 rated cable.

Printing is too slow. • You may be using High or Maximum print quality. See 
page 4.10. The higher quality, the lower speed.

• If you are using Windows NT, the Scheduling setting may 
be set incorrectly. From the Start menu, select Settings 
and Printers. Click your printer icon with the right mouse 
button, select Properties, click the Scheduling tab. 
Then, select the desired scheduling setting from the 
available choices.

Your product prints 
only in black

• The Samsung SCX-1100 Series printer driver may not be 
selected. Verify that you selected the Samsung SCX-1100 
Series printer driver.

• The colour print cartridge may not be working properly. 
Print a test page to make sure the ink cartridges are 
working correctly.

• The print nozzles of the colour print cartridge may need to 
be cleaned. Clean the print cartridges. See page 6.3.

• You may be using Black Only in your printer driver.

Symptom Cause and Solution
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Colour Printing Problems

Symptom Cause and Solution

Colours print 
incorrectly

• The Samsung SCX-1100 Series printer driver may not be 
selected. Verify that you selected the Samsung SCX-1100 
Series printer driver.

• Print cartridges may be installed in the incorrect holders. 
Remove each print cartridge that is in  an incorrect holder. 
Check that the ink have not mixed in the cartridges. If this 
is the case, replace the cartridge with a new one.

• Print a test page. If the problem persists, replace the 
cartridge with new one.

• Print nozzles on the colour print head may be clogged. 
Print a test page to check the status of the nozzles and 
clean the print cartridge (page 6.3).

Colours are missing • The colour print cartridge may not be working properly. 
Print a test page to make sure the ink cartridge is working 
correctly.

• The print head may need to be cleaned. Clean the print 
cartridges (see page 6.3).

Colours in a line are 
uneven, or different 
from the previous 
lines

• You may have turned the product off(paused) and then 
on(resumed) during print job. Do not turn the product off 
and back on during a print job.

• Set the print quality to High or Maximum in the printer 
driver.

• Align the print cartridges. See page 6.14.

Hue changes • Print nozzles on the print head may be clogged. Print a 
test page to check the status of the nozzles and clean the 
print cartridge (page 6.3).

• The colour print cartridge may be empty. Replace the 
cartridge with a new one.
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Print Quality Problems

Symptom Cause and Solution

Light print or fade • The print cartridge may be running out of ink. Install a 
new ink cartridge.

• The paper may not meet paper specifications (for 
example, the paper is too moist or too rough). See “Paper 
Selection” on page 4.2.

• If the whole page is light, the print resolution setting is 
too low. Adjust the print resolution within the printer 
properties. See page 4.10.

• A combination of faded and smeared defects may indicate 
that the print cartridges need to be cleaned. See 
“Cleaning Print Cartridges” on page 6.3.

Splashed dots • The paper may not meet paper specifications (for 
example, the paper is too moist or too rough). “Paper 
Selection” on page 4.2.

• The print nozzles may be clogged with ink. See “Cleaning 
Print Cartridges” on page 6.3.

White streaks or 
missing dots

• The moisture content of the paper is uneven or the paper 
has moist spots on its surface. Try a different kind or 
brand of paper.

• Print cartridges may be installed incorrectly. Make sure 
the print cartridges are installed correctly.

• A print cartridge may be empty. Check the contacts of the 
print cartridge. If there is not any ink in the cartridge, 
replace it with a new one.

• The print media being used may not be acceptable. Use 
only print media specified in “Paper Selection” on page 
4.2.

• The print head may be aligned incorrectly. Print the 
alignment pattern to align the print cartridge. See page 
6.14.

Blurred or smudged 
ink

• You may printing on the wrong side of the paper. Turn the 
paper over and print on the other side.

• The paper may not meet paper specifications (for 
example, too moist or too rough). See “Paper Selection” 
on page 4.2.

• Let the ink dry before handling the paper.
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Characters with white 
lines

• The print cartridge may be almost empty. Check the 
contacts of the print cartridge and replace, if necessary.

• The print cartridges may need to be cleaned. See page 
6.3.

Characters are 
improperly formed or 
not aligned correctly

• The print media is loaded incorrectly or is an unsupported 
size or type. Use the print media specified in “Paper 
Selection” on page 4.2.

• If characters are improperly formed, producing a wavy 
effect, the scanner unit may need servicing. 

• The print cartridges may need to be cleaned. See page 
6.3.

• The print cartridges may need to be aligned. See page 
6.14.

Vertical lines in tables, 
borders and graphics 
not smooth

• The print cartridge may need to be cleaned. See page 6.3.

• The print cartridge may need to be aligned. See page 
6.14.

Solid black areas 
contain white streaks

• Change the fill pattern in the application software.

Printing appears 
jagged

• The print resolution selected in the printer driver may be 
low. Check the printer driver for the correct resolution. 
Printing in low resolution will give the printout a jagged 
look. Change the Print Quality to a higher resolution.

Symptom Cause and Solution
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Scanning Problems

Symptom Cause and Solution

The scanner does not 
scan.

• Make sure you place the document to be scanned face 
down on the document glass.

• There may not be enough available memory to hold the 
document you want to scan. Try the Pre-Scan function to 
see if that works. Try lowering the scan resolution rate.

• The USB or parallel cable is not connected properly.

• The USB or parallel cable is defective. Swap the cable with 
a known good cable. If necessary, replace the cable.

• If using a parallel cable, ensure that it is compliant with 
the IEEE 1284 standard.

• The scanner is configured incorrectly. Check scan setting 
in the SmarThru Configuration or the application you want 
to use to make certain that the scanner job is being sent 
to the correct port (for example, LPT1).

The unit scans very 
slowly.

• Graphics are scanned more slowly than text.

• Communication speed becomes slow in scan mode 
because of the large amount of memory required to 
analyse and reproduce the scanned image. Set your 
computer to ECP printer mode through BIOS setting. It 
will help to increase the speed. For details on how to set 
BIOS, refer to your PC documentation.

The following message 
appears on the 
computer screen: 
Scanner is busy 
receiving or printing 
data. When the 
current job is 
completed, try again.

There may be a copying or printing job in progress. When 
the current job is completed, try  the job again.
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8 APPENDIX

This chapter includes:

•Printer Specification

•Scanner and Copier Specification

•General Specification

•Paper Specification
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Printer Specification

Scanner and Copier Specification

Item Description

Emulation HBP(GDI)

Resolution True 600 x 1200 dpi, 2400(H) x 1200(V) dpi

Printing speed (Draft Mode) 14 ppm (Mono)
7 ppm (Colour)

Effective printing width 203 + 1 mm

Item Description

Scanning method CCD, Flat-bed

Scan resolution 600 x 600 dpi, 1200 dpi class

Scan mode True colour, 256 grey, Black and white

Copy mode Colour, Black and white

Effective scanning width 210 mm

Maximum document width 216 mm

Multi copy range 1 ~ 99

Reduction & Enlargement 25% ~ 400% in 1% increment

Maximum print edge margin Top: MAX 4mm
Bottom: MAX 5mm
Side: Letter — 6.5 ± 2 mm
         A4 — 3.5 ± 2 mm
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General Specification

Item Description

Input paper tray capacity 100 sheets (Maximum)
Stacking Height : 9 mm

Output tray capacity Maximum 30 Sheets

Operating Environment Temperature: 5-40 degrees C (20 ~ 80% RH)

Paper size and weight A4, Letter, Legal

Original document width and 
weight

8.5 inch x 11.69 inch (A4/Letter Sized)

Power rating See Rating Label attached on the back of the 
machine.

Power consumption 10 W in Power save mode
15 W in Standby mode
30 W during copy

Weight 12.4 lb /7.8 kg

Dimensions (WxDxH) 18.7 x 16.9 x 9.9 inch (476 x 429 x252 mm)

Ink Cartridge Life Black Cartridge   High yield: 1,100 sheets
                         Standard: 600 sheets
(based on ITU 5% chart - see “A Sample of ITU 
5% Chart (reduced to 60%)” on page 8.5. 

Colour Cartridge    High yield: 625 sheets
                           Standard: 275 sheets
(based on ITU 15% chart)

Photo Cartridge: 450 sheets
(based on ITU 15% chart)
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Paper Specification

Item Description

Paper types 
available

Plain paper, OHP film, Label, Envelope, Card, Postcard

Paper sizes Paper Type W x L (mm) W x L (Inch)

Letter 215.9 x 279 8.5 x 11

Legal 215.9 x 355.6 8.5 X 14

JIS B5 182 x 257 7.17 x 10.12

A4 210x 297 8.27 x 11.69

Executive 184.2 x 266.7 7.25 x 10.5

A5 148.5 x 210 5.85 x 8.27

A6 card 105 x 148.5 4.13 x 5.85

Post Card 4x6 101.6 x 152.4 4 x 6

HagaKi 100 x 148 3.94 x 5.83

Envelope 7-3/4 98.4 x 190.5 3.88 x 7.5

Envelope COM-10 105 x 241 4.13 x 9.5

Envelope DL 110 x 220 4.33 x 8.66

Envelope C5 162 x 229 6.38 x 9.02

Custom 76 ~ 216 x 
127 ~ 432

2.99 ~ 8.5 x 
5 ~ 17
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Replacing the Fitted Plug (UK)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 
plug and has a 13 amp fuse. When you change or examine the fuse, you mu
re-fit the correct 13 amp fuse. You then need to replace the fuse cover
have lost the fuse cover, do not use the plug until you have another fu
Please contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be su
However, some buildings (mainly old ones) do not have normal 13 amp plu
sockets. You need to buy a suitable plug adaptor. Do not remove the mou
plug.

Warning

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock if you plug it

Important warning: You must earth this machine

The wires in the mains lead have the following colour code:

¥ Green and Yellow: Earth

¥ Blue:                    Neutral

¥ Brown:                 Live

If the wires in the mains lead do not match the colours marked in your 
do the following:
You must connect the green and yellow wire to the pin marked by the let
or by the safety Earth symbol  or coloured green and yellow or green.
You must connect the blue wire to the pin which is marked with the lett
or coloured black.
You must connect the brown wire to the pin which is marked with the let
or coloured red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution



8.7Appendix

Notes For Use of This Device (New Zealand)

The grant of a Telepermit for any item of terminal equipment indicates 
that Telecom has accepted that the item complies with minimum condition
connection to its network. It indicates no endorsement of the product b
nor does it provide any sort of warranty. Above all, it provides no ass
any item will work correctly in all respects with another item of Telep
equipment of a different make or model, nor does it imply that any prod
compatible with all of Telecom s network services.

This equipment shall not be set up to make automatic calls to the Telec
Emergency Service.

This equipment may not provide for the effective hand-over of a call to
device connected to the same line.

Important Notice

Under power failure conditions, this telephone may not operate. Please 
a separate telephone, not dependent on local power, is available for em
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Declaration of Conformity (European Countries)

Approvals and Certifications

The CE marking applied to this product symbolises Samsung Electronics Co., Ltd. 
Declaration of Conformity with the following applicable 93/68/EEC Directives of 
European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the 
member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of 
the laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their confor

A full declaration, defining the relevant Directives and referenced standards ca
obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications 
Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single 
terminal connection to the analogue public switched telephone network (PSTN) in 
accordance with Directive 1999/5/EC. The product has been designed to work with 
the national PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electron
Ltd. in the first instance.

The product has been tested against TBR21 and TBR 38. To assist in the use and 
application of terminal equipment which complies with this standard, the Europea
Telecommunication Standards Institute (ETSI) has issued an advisory document 
(EG 201 121) which contains notes and additional requirements to ensure network 
compatibility of TBR21 terminals. The product has been designed against, and is 
compliant with, all of the relevant advisory notes contained in this document. 
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AC power 1.9
alignment, cartridges 6.14

B
black copy 1.5, 3.6
booklet, print 4.11

C
cancel

copy 3.6
print 4.7
scan 5.5

cartridge
align 6.14
clean 6.3
install 1.12
maintain 6.2
purchase 6.9
replace 6.9

cartridge holder
clean 6.8
location 1.3

clean
cartridge 6.3
cartridge contacts 6.8
nozzle 6.6

clone, special copy 3.11
collate, print 4.10
colour copy 1.5, 3.6
contrast

copy 3.8
print 4.14

control program 4.17
copy

contrast 3.8
page 3.8
quality 3.7
size 3.9
special option 3.10

D
default setting

contrast 3.13
copy page 3.13
quality 3.13
zoom rate 3.13

document
type setting from printer 4.10

document glass
clean 6.17
load, document 3.4

E
envelope, load 4.4
error message 7.5

F
fax gate, configure 2.8
fit to page, special copy 3.10

H
handout, print 4.13
help list, print 6.17



I
ink level, view

from control program 4.18
from operation panel 6.3

ink save 1.6
install

cartridges 1.12
product 1.7
software 2.4
system requirement 2.3

internet gate, configure 2.8

J
jam, clear 7.2

L
language, change 1.17

M
MFP driver

install 2.4
uninstall 2.12

mirror, special copy 3.12

N
nozzle, clean 6.6

O
orientation, print 4.10

P
Paper

guideline 4.2
jam 7.2
load 1.10

paper save 1.19
paper size

set for copy 3.2
set for PC print 4.10

paper type
select guideline 4.2
set for copy 3.3
set for PC print 4.10

parallel, connection 1.8
photo cartridge 6.9
poster

copy 3.12
print 4.12

print quality 4.10
printer control program 4.17

R
reverse page order 4.10

S
save

ink 1.18
paper 1.18

shading, adjust 6.16
SmarThru

install 2.4
uninstall 2.13

special paper, load 4.4

T
TWAIN, scan 5.6
two-sided print 4.13

U
uninstall

printer driver 2.12
scan driver 2.12
SmarThru 2.13

USB
connection 1.8

W
web smoothing 4.10
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